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ARGES Nitrate Sensor Manual

Product Overview

The ARGES Nitrate sensor is a submersible selective ion sensor built for taking sustained measurements of dissolved Nitrate levels in
water sources such as rivers and lakes. The sensor is manufactured from high grade PVC tube, fitted with a wet mate network
connector, and is designed to conserve power, making it ideal for remote operations. It can be used standalone or as part of a
multiparameter system (such as the ARGES SONDE). Like all the ARGES selective ion sensor range, it has a built-in temperature
sensor for measurement correction that can also be used to record the sample temperature.

The sensor is user configurable and supports the SDI12 V1.4 protocol.

Product Images

This is a photograph of the Nitrate Sensor, featuring a sleek black finish with its name prominently displayed for easy identification.

ARGES NITRATE

Figure 1 Figure 2 Figure 3 Figure 4

QLOG Applications Software

The ARGES Nitrate sensor is supplied with a copy of the QLOG applications software. QLOG gives the user the ability to make
configuration changes, take measurements, display real-time measurements and store results in spreadsheet format CSV text files for
easy analysis.
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The images above show real-time measurements of Nitrate in a series of panel meters and charts.
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Nitrate Technical Features

Solid state ISE sensor
Temperature range
Measurement range:
Nitrate Resolution:
Nitrate Accuracy:
Operation

Sensor life:

Long storage shelf life
Integrity

User Range

pH

Interference IONS

SDI12 v1.4 Units

0-50°C

0.1 to 62,000 ppm - User Defined Range

0.01 ppm

+/- 10 % of reading - depending on the calibration and use.
Stand-alone / multiparameter solutions.
Recalibrate after 500 hours

Dry storage

Built in serial number / Latest Calibration Date
User defined sensor range - Maximum / Minimum
2-11

Cl-, NO--

ppm, mg/L, mols/dm?®

Table 1
The calibration procedure used with the Nitrate sensor follows the same procedures as described on page 9 for all of the ARGES range

of selective ion sensors. The easiest way to calibrate a selective ion sensor is to use the free QLOG software and set the sensor to
calibration mode. Full calibration details are shown on page 14.

Measurement Integrity

A solid state sensor makes measurements using reference and selective ion half cells and is suitable for long term submerged
operations. For best results it should be deployed into slow moving or stationary water.

The ARGES Nitrate sensor is factory calibrated at 2 points, which should bracket the expected value for Nitrate concentration in the
water. Selective ion sensors cannot be calibrated at a zero point, even with deionised water.

The ARGES Nitrate sensor is factory set to provide readings in ppm at the raw sensor temperature, and compensated readings based
on the calibration temperature.

where
1 ppm =1 mg/mL
1 ppm of Nitrate = 1.61E-05 mols/dm?

User calibration features are included in the QLOG software supplied with this sensor.
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Measurement Variables
The following variables are available for use with the Nitrate sensor.

The user can adjust the order and measurement variables being sent out from the sensor. Additional concentration parameters can be
added to the sensor on user request.

Letter Description Name Units
Main Sensor Readings
A Raw Concentration Output ppm
B Raw Concentration in mg/mL mg/mL
C Raw Concentration in mol/dm? mol/dm?
E Raw Chemical Sensor Reading millivolts
G Temperature Compensated Concentration ppm
H Temperature Compensated mg/mL mg.mL
Temperature Compensated mol/dm? mol/dm?
M Temperature °C
Table 2

Variable Selection

The flow chart below shows the parameters from Table 2 and how they are calculated and referenced
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s \ measurement (ppm)
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Figure 7
Default Output Parameters : AMGE
Where:
A = Uncompensated concentration in ppm M = Sample Temperature in Deg C
G = Temperature compensated concentration in ppm E = Raw sensor reading in millivolts.
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ri] Edit Sensor Configuration 7 X
Property Value tool Set
dentify T4KEYNESCOISELECT17NitrD003
Probe Type Mitr*[SELEC:D Tool | Set
Serial number 0003 Tool ~| Set
Minimurm underrange 0.10000 Tool | Set
Maximum overrange 1200.0 Tool | Set
Output variables AMGE Tool | Set
Molecular ion mass g/Mol 1.0000 Tool | Set

Figure 8 - Output Parameter Selection - Sensor Configuration Window QLOG - Output AGME

Communications with Windows PCs Using SDI12

The simplest way to configure and take measurements with the sensor is with a USB-SDI12-AG1 media converter connecting the
sensor to a windows device, and using the free QLOG software downloadable from the Keynes Controls website.

Equipment Required:

1. USB-SDI12-AG1 Figures 9-12, USB to SDI12 media converter for use with the ARGES chemical sensors
2. USB Cable Figure 13, Type 2.0 Male A to Type Male B cable
3. ARGES Network cable Figure 16
4. ARGES Extension cable Figure 15
Software

Use the Keynes Controls QLOG software

Download a copy from the www.keynes-controls.co.uk website and install onto a Windows Operating system computer.
The software should run on Windows XP, 10 and 11 operating systems.

The software can be used without restriction. Any similar software that supports SDI12 network operations can be used instead.

Figure 9 Figure 10 Figure 11 Figure 12

Figures 14 and 16 show the network cables used with all ARGES chemical sensors.

Figure 13 USB 2.0 Type A Male to Type B Male Figure 14 Figure 15 - ARGES Sensor network extension cable Figure 16 - ARGES Network Cable
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Figure 17 ARGES Nitrate Sensor Figure 18 - ARGES network cable attached to the Nitrate sensor.

Hardware Installation

The cables used with the ARGES Nitrate sensor, media converter and network cables can only be fitted together in a single
combination. It is not possible to connect the instrumentation together incorrectly.

1. Connect the USB cable into the base of the USB-SDI12-AG1 media converter. See Figures 10 and 13 on page 3 above.

2. Connect the orange extension cable or ARGES network cable to the blue binder connector on the USB-SDI12-AG1 media
converter. See Figures 11 and 12 on page 3, or 18 and 19 below.

Network cable connection to the USB-SDI12-AGI media

converter.

Figure 18 shows the network cable alignment to the
USB-SDI12-AG1 media cable.

A white marker on the Blue Binder connectors has to
line-up for the cable to push onto the media converter.

—— ¢ Figure 19 shows the network cable terminated onto the
media converter.

Figure 19 Figure 20

3. The black ARGES network cable shown in figure 16 above, is waterproof and safe for submergence with the Nitrate sensor. It
is terminated with a moulded 5-pin connector that fastens to the sensor and a blue IP68 rated Binder connector.

The 5-pin sensor terminating socket on the network cable is moulded into the cable end and ensures high integrity and reliable
connection. The moulded socket is wet mate capable.

The orange extension cable is terminated with Binder IP68 plugs.

4. Terminate the ARGES network cable to Nitrate sensor. It only fits one way onto the gold connector at the rear of the sensor. See
Figure 20 below.. Lock into place on the sensor using the red securing ring.

5. Using the USB interface cable, Plug the USB type A socket into a standard USB port on the Windows PC. See Figures 9 and 13
on page 3 for more details.

As long as the Windows PC is powered on, and the USB port is operating to the correct technical specification then the blue
status LED on the USBSDI12-AG1 media converter will illuminate. See Figure 12 on page 3.
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Figure 21 - ARGES Network Cable Figure 22 - ARGES Network Extension cable

Powering the ARGES Nitrate Sensor

The ARGES Nitrate sensor is powered directly from the PC USB port via the USB-SDI12-AG1 media converter. This makes
measurements and calibration operations very easy. A Windows laptop can supply enough power through a USB port to power any of
the ARGES Sensors.

The USB-SDI12-AG1 media converter can power single sensors and multiparameter systems directly from the PC USB Port.

Figure 23

USB-SDI12-AG1 Device Drivers

The device driver software for the usb media converter automatically loads into the PC so long as an Internet connection is made. The
media converter uses the FTDI chipset and the driver software that is usually already part of Microsoft Windows.

Plug the USB cable supplied with the USB-SDI12-AG1 media converter into a windows PC. The blue status indicator visible in figure 20
will switch on to indicate that the chosen port is operating correctly.

Further Information
All items shown in this document are available from the Keynes Controls online shop.

See keynes-controls.co.uk for details, or E-mail sales@keynes-controls.com
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Pin-outs
The pin-out is standard on all of the ARGES range of chemical sensors.

View looking into the sensor connector.

Figure 24
1= -RS485 2=+ RS485 3 =SDI12 Data 4= Gnd 5=+12V DC

Downloading QLOG

A free copy of QLOG can be downloaded from https://keynes-controls.co.uk/g-log-software/.

QLOG Software Quick User Guide

The ARGES Nitrate sensor supports multiple digital communication networks. This manual only considers using the SDI12 network for
communications using the USB media converter and QLOG software.

Required Information:
1. COM Port used by the USB-SDI12-AG1 media converter.

Use the Device Manager feature of the operating system to locate the USB-SDI12-AG1 COM port number.

B QLog Recorder - o x| Enterthe USB media converter COM port number into

Qlog View Edt_Help = the QLOG Software Configuration Window.
v egging Configuration ? X
Devicelist | variablelist | Formuas — Alarm Leve . . .
conre [ETER - The QLOG software has to identify the media converter
Col Alarm Low v Alert High u
G > e so the sensor measurements can be read.
2 B Logging Interval IWL’
3 e Fetame Select QLOG - Configuration menu option
d o |20250411_1742.txt
5 E
[ e IF f= The Window opposite will appear. Select the COM port
7 Js rede oz = number from the pull down list. In the example COM
8 H
ort 3 has been selected.
o = L °
1 | >

|QLOGIVer: 2024 02 Copynght Keynes Contiais|C)/2012:2024 IS

Figure 25 - QLOG Configuration Window
Network Selection

The ARGEs Nitrate automatically detects the network on which has been connected by reading the network traffic.

The USB-SDI12-AG1 media converter used with the ARGERS Nitrate sensor only supports the SDI12 network. Upon connecting the
media converter to the instrument then the SDI12 network will be activated.

Select SDI-12 menu option from the pull down list. See Figure 25 above.
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Recommended Sample Rate
1. A single sensor connected directly to a PC or similar data acquisition system
Maximum sample rate 1 Second
Recommended sample rate 10 Seconds
Once all the configuration settings have been assigned press the ‘OK’ button to store.
The slower the sample rate, the longer the sensor will last before recalibration is required.
Multiparameter Housing Sample rate
2. The fastest sample rate for a fully populated 7 Port SONDE is 10 Seconds
Recommended sample rate is 30 Seconds.

It is now possible to scan the network and identify the sensor

Scanning the SDI12 Network

Select F9 on the PC keyboard, or select ‘Scan for Devices’ from the QLOG menu system

o | R —

'QLOG Ver. 2024002Copyright Keynes Controls (C) 2012:2024 4

Figure 26 Figure 27

The USB-SDI12-AG1 media converter status indicators will flash on and off, see Figure 27 above.

Identify Nitrate Sensors in the SDI12 Network.

The SDI12 network supports 10 sensors each with an individual ID number for identification. The SDI12 ID number is an integer ranging
from 0 to 9. Each sensor has a unique ID address, and supports an enhanced address mode to allow additional devices on the same
network.

Each sensor also has an Product Description string, in the case of the Nitrate sensor this is

a14KEYNESCOISELEC107Nitr
This has been assigned by Keynes Controls Ltd and is a standard feature of the SDI12 protocol.
where a = ID number of the sensor n = Number of sensor type on a network.
Factory Default settings :  ID = 0 for all sensor types

Once the Nitrate sensor has been identified on the network then it will appear under the Device list tab in the QLOG Software
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7 Qlog Recorder - o0 x Figure 24 opposite shows a Nitrate sensor
Qlog View Edit Help with ID 0 on the SDI12 network.

1

DeviceList | variablelist | Formulas | AlarmLevels |

List of devices.

{0I!014KEYNESCOISELEC107Nitr0003 \ARGES Nitrate D.G Setup | Config | IDv1 4[ u

u

P =l
Logging N Stopped at 13:01:34

Figure 24 - Device List after a network scan

Figure 33 shows a typical network scan when multiple sensors are being used and has identified a Nitrate sensor. The QLOG software
does not yet understand what has to be done with the measurements that will be returned from the sensor or sensors.

Note. The 4th column shown in Figure 28 shows the cell locations where the measurements will be stored in the results file.
The QLOG software uses the same cell references as common spreadsheets.

The Nitrate sensor above is shown storing measurements into cells D .. G.
Use the Auto-assign option in the main QLOG menu option to enable software to automatically adjust the cells.

The first three cells referenced A..C are reserved and cannot be used by the User. The cell references are the same as those used by
most spreadsheet programs.

Understanding the Sensor Parameters

An SDI12 sensor can return multiple measurements back to the PC or any other data acquisition system controlling the network.

The QLOG software has to be told which measurements the ARGES Nitrate sensor will be sending to the PC in order to make sense of
the results.

The ARGES Nitrate sensor is preset to return the following values:

Raw Nitrate Concentration ppm
Sample Temperature °C
Temperature Corrected Nitrate concentration ppm
Raw sensor reading millivolts

Nitrate Measurements

Select the ‘Setup’ Button. See column 4 in Figure 28.

I.R Setup | Config | IDv14
5.AB Setup | Config | IDv1.4
ACLAL Setup | Config | IDv1.4

AM..AQ Setup | Config | IDv1.4
Figure 29

The Device Setup Window shown in Figure 30 will appear.
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[ BB Device Setup :  x | Figure 30 opposite shows the QLOG device setup window for the current Nitrate sensor.

Device ID

o Select the ‘OK’ button.
Configuration
atratesenor | Ensure the ‘Nitrate Sensor’ option is shown in the Window. Adjust with the pull down menu options as
strt Column necessary.
3 =

The Start column into which the measurements are to be stored is defined under the ‘Start Column’ tab.
In the example the cell location is shown as ‘A’. This can be adjusted. Any cell after D required.

Cancel

The Auto Assign function will assign the correct cell location for measurement storage automatically.

Figure 30 - Nitrate Device Setup Window 0 o] the sensors on a network have been identified and set the cell locations for the measurements

can be automatically assigned.
Repeat for all sensors on the network.
Once the Nitrate sensor has been identified then the measurements can be stored into the results file
Using the menu system shown below

Select ‘Auto Assign’ menu option.

Scan for devices
Start Logging The menu is also used to start and stop the data acquisition operations, change the sensor ID, etc.
Stop Legging
B The QLOG sensor can now be used to make measurements. Everything is configured.
Auto Assign
Save

GSM

Import/Export

Figure 31

The sensor will return four parameters after each measurement: raw Nitrate reading (ppm), sample temperature (°C),
temperature-corrected Nitrate concentration (ppm), raw sensor reading (mV).

1 Qlog Recorder - 0 x Once the Auto Assign function has been
S 0 B G activated then the cell references used by the
Device List | Varisble List | Formulas | Alarm Levels dlﬁerent sensors are automatlcally aSSIQned'
List of devices . . . .
DIDT4KEYNESCOISELEC1O7Nit D003 ARGES Nitrate 0.6 Setup | Config [ IDv14[ = Flgure 33 opposite shows a Device List for a 7
Port multiparameter SONDE with a Nitrate
j sensorsetas D 1.
"
[7
p -
Logging N Stopped at 13:01:34
Figure 32
87 Qlog Recorder o X
Qlog View Edit Help b
Device List | Variable List | Formuiss | Alarmlevels |
List of devices
0 e D.D Setup | Config | IDv14] |
111114KEYNESCOISELEC106Nitr001 |ARGES Nitrate E.H Setup | Config \DvWAI
61!614KEYNESCOISELEC 106Nitrite0001 Nitrite LR Setup | Config | IDv1.4]
[7II714KEYNESCOFLOURSO1 7Tryp0001 Tryptophan Fluor 5.AB Setup | Config | IDv1.4]
181!814KEYNESCOFLOURSO17Turb0002 [Turbidity |AC.AL Setup | Config | IDv1.4]
91!914KEYNESCOFLOURSO17DisQ0001 Disolved Oxygen (optical) AM.AQ Setup | Config | IDv1.4]
al!a14KEYNESCOFLOURS017CDOMO002 CDOM/FDOM sensor IAR.AV Setup | Config | 1Dv1.4]
Ad]
Logging N Stopped at 14:27:08
Figure 33
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Real-time Measurements

1 Qoo Recorder

Qlog View Edit Help

Scan for devices

Devielst Varable st | Formuas | Aamievels

Start Logging

Col

Variable

Name Units Current

Step Logging

no. 1307
v/m/D Fri, 29 Aug 2025

Change Address

s 15:41:00

Nitate Level
ManualCommand T
Nitrate-Temp

Auto Assign

BERNHEERES

Save - —
G5M

Nitrate Con;

Nitrte-Temp:

ppm 2222
Deg C 22039
89474
23889

785

o

o

Import/Export

[Logging N~ Stopped at 15:41:33

Figure 29

Changing the sensor ID number

Figure 30 Real-time measurements

It is possible to change the sensor ID number using the QLOG software.

The simplest way is to use the Change Address option from the QLOG software.

Select the ‘Change Address’ option as shown below.

[87 Change Device Address ? x
Scan for devices
Start Logging
Stop Logging IF
Change Address IZI!214KEYNESCOISELEC 117Mitr0003 j

ManualCommand

Auto Assign

To
PR - |

GSM
Import/Export

Figure 36

ARGES Nitrate Sensor Manual - Version 1.01

Figure 37 - Change Address Window
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In order to observe measurements from the
Nitrate sensor, select the ‘Start Logging’
option.

The status indicators on the
USB-SDI12-AG1 indicator will flash as
measurements are sent from the sensor.

The light level shown is the background
level at the time of measurements.

The example shows the Change Window
configure to adjust a sensor with original ID of 2
toanew ID of 4

Press the ‘Set’ button to store the new ID.

The QLOG software will scan the network to
identify the sensor.

Make sure each sensor has a unique ID
number.
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Calibration Solutions

Calibrating the ARGES Nitrate sensor requires two calibration solutions, which should bracket the expected value of the solution to be
measured. These solutions are most easily made from a base solution of 1000 ppm, which is then diluted down to the desired
concentration.

The following table presents the ratios to make a variety of concentrations of solution, as well as the masses necessary to make 200 ml
of solution at that concentration. Add the specified masses to 200 g of water.

lon Solute ppm Ratio Mass for 200 ml
Nitrate Sodium Nitrate (99% pure) 1000 ppm 1: 721 0.277 g
Nitrate Sodium Nitrate (99% pure) 500 ppm 1:1443 0.139¢g
Nitrate Sodium Nitrate (99% pure) 200 ppm 1:3610 0.055¢g
Nitrate Sodium Nitrate (99% pure) 100 ppm 1:7221 0.028 g
Table 3

Base Concentration Calibration Solution
The base calibration solution is the one from which the lower calibration solutions are derived.
Using 0.136 g Sodium Nitrate in 100g of water gives a 971 ppm solution, from which the diluted calibration standards are derived.

Using these values will provide a solution with a concentration of 971+1 ppm so long as the Nitrate Chloride weight is measured
correctly using a chemistry scale.

Common range of Nitrate in UK rivers is within the range 0.1 to 100 ppm so the example demonstrates sample calibration levels. Do not
attempt a zero point calibration.

Additional Calibration details can be found at:

Calibration Solutions | Keynes Controls Ltd https://keynes-controls.co.uk/calibration-solutions/

High Level Calibration Solution

To produce a 97.1 ppm calibration solution, dilute the above 971 ppm solution with deionised water in a 1 : 9 ratio (for example 10 ml of
solution in 90 ml of deionised water).

Low Level Calibration Solution

1:4 dilution of the 97.1 ppm standard calibration solution gives 19.4 ppm (for example, 20 ml of solution in 80 ml of deionised water).

Materials Required for Sensor Calibration
The Nitrate sensor requires the same items for calibration as all other sensors in the ARGES selective ion range:

High concentration calibration solution
Low concentration calibration solution
Beaker of distilled/deionised water

2 glass beakers

Temperature probe

Sensor stand (ideal but nonessential)
Magnetic stirrer (ideal but nonessential)
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Sensor Calibration

1. Set up the sensor on a stand as shown in figure 18 (page 6)
2. Ensure the sensor is connected to a Windows PC and communications are configured.

The calibration procedure used with the Nitrate sensor is the same as for the entire range of ARGES selective ion sensors. The easiest
way to calibrate a selective ion sensor is to use the free QLOG software and to set the sensor into configuration mode.

Make test measurements at the 2 calibration points. Record the raw values and sample temperature.

For normal river monitoring the calibration points mentioned above will be satisfactory for many applications. Once some idea as to the
levels of Nitrate in the water source is known then the sensor calibration factors can be adjusted to be closer in range for higher
accuracy results.

Clean the sensor in deionised water before sampling with the second calibration solution. Make sure the sensor is clean.

Use the temperature sensor built into the ARGES Nitrate sensor to give the sample temperature. When possible, calibrate the sensor at
the temperature into which it will be deployed. Once the sensor is deployed into the calibration solution, wait for the reading to settle
before recording the result.

Enter the raw Nitrate level as measured by the instrument at the known calibration level (ppm). In the example above this will be for
103.6 and 20.7 ppm calibration points. These levels give a good quality sensor reading at the levels expected for sample detection in the
UK.

To enter configuration mode, press the Setup Button’ button adjacent to the sensor requiring configuration changes as shown in Figure
38.

idl!-ﬂ4KEVNESCOISELEC10TNitr{>003 | iD..A | Setup | Configile‘I.—’il
I I Figure 38 I I I I

Calibration Certification

Calibration of the sensor and of the buffer solutions are available as optional extras.

Saving Calibration Information into the sensor.

To store new parameters into the ARGES Nitrate sensor simply enter the new parameter into the table and press the adjacent ‘Set’
button.

If using a Keynes Controls USB-SDI12-AG1 interface then the status indicators will flash briefly indicating that the new parameter has
been sent to the instrument.

&7 Edit Sensor Configuration 7 X

Property Value tool | Set
dentify 14KEYNESCOISELECTTTNitr0003

robe Type NitrAISELEC;D Tool *| Set
erial number 0003 Tool v| Set
inimum underrange 1.00000 Tool *| Set
aximum overrange 12000 Tool *| Set
utput varizbles AMGE Tool v| Set
olecular ion mass g/Mol 1.0000 Tool v| Set
cale mg/L to ppm 1.0000 Tool v| Set
First point millivolts 321.00 Tool v| Set
First point ppm 97.000 Tool *| Set
econd point millivolts 26000 Tool *| Set
cond point ppm 970,00 Tool v| Set
econdary scale factor 1.0000 Tool v| Set
Tertiary scale factor 1.0000 Tool *| Set
Calibration Temperature Deg-C 22000 Tool *| Set
Temperature Correction mV/Deg-C 0.75000 Tool *| Set

Figure 39 Nitrate Sensor Configuration Window

ARGES Nitrate Sensor Manual - Version 1.01 Last Updated 03/03/2026
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Sensor Configuration Parameters Terms

Minimum Underange

Maximum Overanage

Output Variables

Molecular mass

Scaling factor ppm to mg/L
Scaling factor ppm to mol/dm?

First point millivolt

First point ppm

Second point millivolt

Second point ppm

Secondary scale factor
Tertiary Scale factor
Calibration Temperature
Temperature Correction mv/°C

The minimum value that the sensor will return - Any measurement below this value will also
return at the minimum set level. eg \Minimum underrange = 10 ppm then any reading less than
this level will show as 10 ppm.

This is the maximum value that the sensor will return - Any measurement above this value will
also be returned at the maximum set level.

User selectable outputs variables - Table 1 page 3 - Default = AMGE

Mass of the molecule in atomic units.

Typical value = 1.00 can be adjusted to allow for variations in density for dissolved ions.
Typical value = 1.61E-05

Raw sensor reading in millivolts with the sensor deployed into first calibration standard solution.
Example 97.1 ppm solution - 294.9 millivolts -

First point millivolt = 294.9 mV

First point calibration standard solution ppm - as above

First point ppm = 97.1 ppm

Raw sensor reading in millivolts with the sensor deployed into first calibration standard solution.
First point calibration standard solution ppm - as labelled

Scalar number - used to calculate mg/l from ppm -

Scalar number - used to convert ppm to mol/dm?® - useful for high concentration readings
Temperature for which the calibration was taken.

Variation in raw sensor millivolts with temperature change - can be a positive or negative value.
Table 4

ARGES Nitrate Sensor Configuration Settings

The ARGEs Nitrate sensor is fully user configurable. Figure33 above shows the Configuration Window for the Nitrate sensor.

Setting the Nitrate Calibration Parameters

The sensor uses a 2 point calibration system to report measured concentration levels.

First Point Calibration

Second Point Calibration

321.00 mV
260.00 mV

97.1 ppm calibration solution
971.0 ppm calibration solution

The value of 431.04 is the measurement reported from the ARGES Nitrate sensor in Manufacturer Setup Mode using a 100 ppm test
solution. To store new parameters into the instrument configuration select the ‘Set’ button. The sensor reading in millivolts will vary
between sensors and over time.

The ISE sensor requires two calibration points - a high concentration value and a low concentration value. It does not matter if the

values are entered high then low or low then high. It is not possible to use a 0 ppm solution for calibration, a nonzero low value must be
used.

Maximum Concentration Level
The operating range of the ARGES Nitrate sensor is user defined.

Maximum Overange: Sets the maximum level of measurement that the sensor can return
Maximum Overange: 1,200 ppm See Figure 40 below.

In this example a ARGES Nitrate sensor has a maximum range of 1,200 ppm.
Any measurement above the 1200 ppm level will return as 1000 only.

The sensor will not return a value greater than 1,200 ppm.
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Minimum Concentration Level

Minimum underrange: Sets the minimum level of measurement that the sensor can return

Minimum underrange: 1 ppm

Note - Nitrate sensor configuration below will be set to operate from 1 to 1200 ppm only.
Should the sensor be calibrated over the range 0 to 100 ppb then the out of range message can be set to operate over the 0 to 100 ppm

range.
87 Edit Sensor Configuration ? x
Property Value tool Set |2
dentify T4KEYMESCOISELECT17Nitr0003
Probe Type Mitr*ISELEC;0 Tool Set
Serial number 0003 Tool Set
Minimum underrange 1.0000 Tool Set
Maximum overrange 1200.0 Tool Set
Cutput variables AMGE Tool Set
Molecular ion mass g/Mol 1.0000 Tool Set
Figure 40

Typical Calibration Curve for lon Selective Electrode

Figure 41 illustrates the response (in voltage) produced by a selective ion sensor when measuring a solution of a given concentration.

Response

Log (Concentration)

Figure 41 - ISE sensor response graph

ARGES Nitrate Sensor Manual - Version 1.01

A selective ion sensor is usually calibrated between two points
(example points here labeled P1 and P2) on the linear section of
the graph. Below a given concentration (the point labelled A on the
graph) the calculation becomes nonlinear, and a sensor expecting
to measure in this region will be calibrated differently. The ARGES
sensor cannot measure this out of the box, but can be set up to do
S0 on request.

Selective ion sensors have a lower limit on the concentration they
can meaningfully detect as the response asymptotically tends
towards a fixed value as concentration lowers.

The calibration points P1 and P2 are chosen to give good reliable
readings in milli-V at the calibration contraction levels.

For river water operations Keynes Controls typically calibrate the
sensor at 97 ppm and 25 ppm.

Where:
P1 =97 ppm
P2 = 25 ppm for the above plot.

Last Updated 03/03/2026
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Output Variables

The ARGES Nitrate sensor can be configured to return any of the variables listed in Table 2 above. The user has the ability to adjust the
measurement parameters being sent out by the sensor..

Figure 42 below shows a sample of the Nitrate sensor Configuration Window where the output variables are assigned.

[87 Edit Sensor Configuration ? x
Property Value tool Set |2
dentify 14KEYMESCOISELECT1TNitr0005
Probe Type Mitr~ISELEC;D Tool Set
Serial number 0003 Tool Set
Minimum underrange 1.0000 Tool Set
Maximum overrange 1200.0 Tool Set
Dutput variables AMGE Tool Set
Molecular ion mass g/Mal 1.0000 Tool Set
Figure 42 - ARGES Nitrate Configuration Window - Return Parameters
aM!aD0! AMGE - returns 4 values for the DO command.
A = Raw Concentration in ppm M = Temperature in °C

G = Temperature compensated concentration in ppm E = Raw sensor reading in millivolts.

aM!aD1! Command - returns 4 values for the D1 measurement command

Set the output variables to be returned from the sensor using the D1 command Sensor Serial Number.
The sensors have a factory set serial number.

Maximum data type: 16 x alpha-numeric characters.

Additional User Defined Output Variables

The aM!aD1! Command can be used to set additional parameters to be sent out by the sensor
4 user assigned variables are used with this command.

Assign the variables from the Table 2 shown in page 2.

Calibration Temperature

This is the temperature for which the calibration operations for the sensor were carried out. Under ideal conditions the calibration
temperature should be close to the deployment temperature for the chosen water source.

Units : °C
Calibration temperature : 18.850 °C

e e e s

|
kahbratun temperature |1B‘850 | Tool Set

braveraioos s [ea nnn |

Figure 43 - Calibration Temperature Setting - Nitrate Sensor Configuration

Enter the calibration temperature and press ‘Set’ to store the new value into the sensor.

ARGES Nitrate Sensor Manual - Version 1.01 Last Updated 03/03/2026
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Manufactures Probe Type ID

This is a sensor type as shown on the device list Window and cannot be user assigned.

Caring for the ARGES Selective lon Sensor

The ARGES selective ion sensors are precision instruments and should be treated with care. It is important that no trace of a previous
sample is left on the instrument as it can affect future readings.

1. Clean the sensor using distilled / deionised water and dry with a soft cloth.
Make sure the channel between the Nitrate half cell and the reference is clean before deployment.

2. Check that the 5 way connection fitted onto the top of the sensor is clean and free of debris/
Remove any debris found between the pins and wash with distilled water. Tap water can be used if required.

Should the sensor have been deployed into a heavily contaminated water source then soak the sensor in Isopropanol Alcohol. This will
kill any bacteria left on the sensor housing.

Figure 37 shows the head of the Nitrate sensor head. The trench between the two sensors is
where the conductive bridge will form and must be cleaned and clear of contaminants.

Figure 44

Figure 38 shows the 5-Pin connector fitted onto the selective ion sensors.

Figure 39 shows the sensor fitted inside a multiparameter housing. A brush
unit can be used to clean the sensor heads between measure operations.

Figure 45 Figure 46

Remove the shade cap and clean the sensors fitted into a multiparameter
housing.

Use deionised water when possible. Dry with a soft cloth

Remove any contamination and detritus before redeployment.

Figure 47 - 3 x selective ion sensors inside a multiparameter housing.
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Dimensions

Figure 39 shows the dimensions of the sensor, which are the same for all ARGES selective ion sensors.
" £0.0 | 168.03 I

S —
&=

Pz

Figure 48
Length: 228mm
Width: 22mm

Sensor Deployment

Figures JJ to LL show the ARGES Nitrate sensor prepared for direct deployment into the water source. Make sure the network cable is
attached and secured onto the instrument. The sensor can be directly connected to the USB media converter for use with a Windows
computer system. The sensor can be directly into a data logger using the SDI12, or RS485 communication networks.

Figure 49 Figure 50 Figure 51

Multiparameter Sensor Deployment

The ARGES Nitrate sensor can be fitted into a multiparameter housing. Use silicone grease on the
5 pin connector to ease the installation onto the housing socket.

The sensor can be fitted into any spare port in the housing. Secure the protective housing shade cap to the base unit
Once the network cable is attached the multiparameter sensor system can be deployed.

Fit the shade cap supplied with the
housing when deploying as a
multiparameter system into a water
source in order to protect the sensor
heads from damage and debris.

Figure 52 Figure 53
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Charts and Panel Meters

The QLOG software can be configured to show real-time measurements on panel meters and charts as shown below

Select the ‘View’ tab from the main QLOG window to select the panel meter and chart options.
The charts support up to 2 Y axis parameters, so Nitrate and temperature values can be shown on the same plot.

Figure 54

Setting Up The Panel Meter Display

Nitrate Con; ppm Nitrate-Temp; Deg C ‘

Figure 55

The QLOG software can present results in a series of User defined panel meters or charts.

The panel meter configuration is the same for all the different panel user assigned panel meter displays.

A typical panel meter display for the ARGES Nitrate sensor is shown above.
To configure the QLOG software panel meter then:

1. Start at the QLOG main menu - Select the ‘View’ Tab

[ QLog Recorder - X
| Qlog [Vien Edit Help
= EL%D
Dey  Chart1 | Formuss | Al Levels |
— Chan2
| chens Varisble Name Units Current jl
G Chana cell millivolts current; my 248
W Console ) Potassium; ppm 62315
|| LCDPancls » bmp Potassium-Temp: Deg-C 178
) Potassium (Comp) Potassium Comp; ppm 528
K m\_main cell millivolts current; mv 29664
L Chloride (raw) Chioride: pom 2511
M Chloride-Temp Chioride-Temp; Deg-C 1783
N Chioride (Comp) Chioride Comp: pom 2767
o m\/_main cell millivolts current; mv 16039
P 0 =]
Logging Y Current record:342 at: 1:51:45  Next Log 13:51:50

Cha

Chart 2
Chart 3
Chart 4

Console
LCD Panels

Figure 57

QLOG Software - View Tab Selection - Figure 56

Select ‘LCD’ Option from the View Tab List.

ARGES Nitrate Sensor Manual - Version 1.01

It does not matter where or how the QLOG software is
configured, or what type and number of sensors are in
operation.

The panel meter configuration is the same.
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A panel meter display will appear but it will require configuration to make it usefull. The display will be the last panel meter configuration
that was previously saved, or used on the Windows device.

+- 2 x 3 Panel Meter Display

Number of Parameters to Display

Currently the panel meter can display up to a maximum of 32 individual parameters on a single display
However for most applications only several parameters from the sensors are required.
1. From the panel meter display select the ‘Edit’ Tab

Note. The panel specification is Column x Row. 2x3 = 2 Columns x 3 Rows.

W 2. Select the number of parameters that are to be displayed.
211x2)

3 (1x3) The greater the number of parameters then the smaller they will appear
Mumber of panels * 4(32) on the display.
6 (3x2)
6 (2x3) Once the number of parameters has been defined then the panel meter
W Titles 9(3x3) display will update to show the changes.
8 (4x2)
v Units 8 (2xd)
10 (52)
Save 10 [2x5)
12 (4x3)
Refrezh )
16 (4x4)
32 (8xd)
32 (4x8)

Colours L4

Figure 60 Figure 61 - Panel List
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Selecting the parameters to be displayed.

1. Select the ‘Links’ tab on the panel meter a menu similar to that shown below will appear.

W Ve it
i Loke
Coni Pt
P2
Panel 3
Pt
Panels
Panel 6
Panel?

Panais
P
Nitri  paai10
Panei 1
Pand 12
Panel 13
Panai 14
Pand 15
Panel 16
Panel 17
Panet 18
Panel 19
Pand 20
Panei21
Panei 22
Panel 23
Panei 24
Panel 25
Panci 26
Panel 27
Panei 28
Panei29
Panel 30
Panei31

Chlc

Panel 32

uS/cm
ppm/I Nitrates Temp
JHHD |
S
ppm/l Chloride Temp
E ( E I
(G N
3
Figure 62

Choose Parameter

- o x

Conductivity Temp  Deg

RERE
7190

Deg C
(C
IE. (JER N

Repeat this operation for each parameter to be shown.

Parameter 1 is always the top left hand corner of the display.
In the panel opposite

Parameters selection is

Panel 1 Panel 2
Panel 3 Panel 4
Panel 5 Panel 6

Select ‘Panel 1’ and this will display a value in the top left hand 7 segment display - The Select variable Window similar to that shown

will appear.
187 Select Variable T X
Col Variable Name Units Select [
Oa Record no. Selec!
s
Os Date ) Select
==
Oc Time himcs Select
==
0D |Nitrite (raw) Nitrite; ppm Select
==
e |Nitrite Temp Nitrite- Temp; Deg-C Select
==
CIF  |Nitrite (Comp) Nitrite Comp; ppm Select
6 |mV_main cell millivolts current; my Select
==
OH  |Potassium (raw) Potassium; ppm Select
==
| |Potassium-Temp Potassium-Temp; Deg-C Select
==
) |Potassium (Comp) Potassium Comp; ppm Select
==
Ok |mY_main cell millivolts current; my Select
==
L |Chloride (raw) Chloride; ppm Select
M |Chloride-Temp Chloride-Temp; Deg-C Select
ON_|Chleride (Comp) Chloride Comp; ppm Select
0 |mV_main cell millivolts current; my Select
—==c
Or Select
—==g
mfs] Seed |

= |

Figure 63

All the sensor measurements that are in use will be displayed in a
table similar to that shown opposite in Fig 63

Choose the parameter to be displayed

Press the ‘Select * button to confirm.

Example: select ‘Nitrate Compensated’ in cell J.

Press the ‘Select’ button and the current temperature compensated

value will appear in the panel meter.

Repeat the operation for all parameters to be displayed.

Once all the parameters are set then close the Select Variable Window

ARGES Nitrate Sensor Manual - Version 1.01
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Saving the Panel Meter Configuration

In order to save the Panel Meter setup once it has been configured select the * Save’ menu option as shown in the figure below.

MNurnber of panels *
Colours 4
v Titles
v Units

Save
Refresh

SDI12 V 1.4 Features

In order to use the SDI12 V1.4 feature for any ISE type sensor ensure it has already been identified on the network and set up. See
page 9 Figure 28 above.

111114KEVNESCOISELEC106Nitr0001 ARGES Nitrate EH | Setup | Config |iDv14|

Figure 64
The Window in Figure 41 will appear
Wait to allow all the parameters in the table to be downloaded from the sensor then press the ‘Update’ button.
The status LED indicators on a USB-SDI12-AG1 media converter will stop flashing once all of the parameters have been sent.
The ARGES Nitrate sensor will report the measu-rements into QLOG with the Sl units for area measurement automatically defined.

If a number of sensors are being used then activating the ‘Auto Assign’ option in the QLOG menu is recommended.

SDI12 V1.4 assigned Sl Units

[ /&7 50112 1.4 Documentation r x The Sl units are preset into the sensor and will automatically assign
Vorinble Name nits_[=] themselves in measurement operation.

4IM_0D1! | 4IM_00114, Nitrate Level, ppm,Nitrate Con; 3 Nitrate L... | Nitrate Cen; ppm ‘
4IM_002! | 4IM_00214,Nitrate-Temp, Deg C Nitrate-Temp; |4 Nitrate-... | Nitrate-Temp; Deg C The sensor can Output COnCentratiOn in the fOIIOWing Units:
4IM_003! | 4IM_003!4 ] m

4M_004! | 4IM_004i4 L] ﬁTpg / L

e mol/dm?

Cmd Response col

4IM_006! | 41IM_00614

4IM_007! | 4IM_00714

Temperature will always be given in °C.

4IM_008! | 4IM_00814

1
2
3
4
5 |4IM_00S! |4IM_00514
6
7
3
9

4IM_009! | 4IM_00814

0 |4IM_010! | aIM_0104

Update Cancel
|
Figure 65 - SDI12 V1.4 S| Units

The ARGEs Nitrate sensor supports the SDI12 V1.4 protocol and as such supplies measurements directly in S| units.
The Sl units for the Nitrate sensor are shown in Figure 43 above.

To store any changes into the sensor select and press the ‘Update’ button.
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Supported Commands

Table 3 below lists the commands supported by the Nitrate Sensor

Start measurement aMm! a05\r\n where 05 = time delay before measurement sent
Send ID al! 14KEYNESCOISELEC Part description assigned by Keynes
Where a = ID number - 0 - 9 (standard) / (a..z) Enhanced SDI-12
0-9/a-zfor RS485
Change Address aAb! where a = Initial address and b = Final address

Make a measurement - a = address of sensor

Address Query 2!

Start Measurement amt Example 1M! starts a measurement for sensor with ID=1

Set Output Variables XCSTRO Sets the parameter order for measurements sent from the sensor - factory set BCDM
Read Serial Number aXSN! Instrument Response a+Serial-number

Calibration Date aXcD! Instrument Response a+date

First Calibration point (ppm) XCAO Typical value = 103.6 ppm

First point uncompensated (mV) XCA1 Typical Value = 417.95 mV

Second point electrical (ppm) XCA2 Typical Value = 20.7 ppm

Second point uncompensated mV) XCA3 Typical Value = 348.45 mV

Temperature Compensation % per Deg-C XCA20 Typical 0.25 % per/Degree C
Table 3

Device List

Figure 44 shows the ‘Device List’ Tab in QLog for a seven port multiparameter housing. Depending on the ID numbers assigned for the
various sensors then this table can vary.

Each individual sensor must have a unique ID/ Address assigned. The Nitrate sensor in Fig 44 has ID = 1.

All sensors identified on a network are listed here.

[#7 QLog Recorder — O ®

Olog View Edit Help I}
u

Device List Variable List | Formulas | Alarm Levels |

List of devices
11013KEYNESCOWIPERADD2wip243101 ARGES Wiper 0.0 Setup | Config |IDv1.4| | =
T T4KEYMNESCOISELECTO6Mitr0001 \ARGES Mitrate E.H Setup | Cenfig | IDv1.4
611614KEYMESCOISELECTOEMitriteD001 Mitrite I.R Setup | Cenfig | IDv1.4
|7I!714KEYNESCOFLOURSO1?TrypODO1 Tryptophan Fluor S.AB Setup | Cenfig | IDv1.4
|B|!314KE\"NESCOFLOURSD1?TurbODD?_ Turbidity ACLAL Setup | Cenfig | IDv1.4
lo11914KEVNESCOFLOURSD17Dis00001 Disolved Oxygen (optical) AM.AG Setup | Config | IDv1.4
allal4KEYMNESCOFLOURSOITCDOMODD2 CDOM/FDOM sensor WAR.AV Setup | Cenfig | IDv1.4 _I
-

Logging N Stopped at 14:27:08

Figure 66

To assign the parameters in the results table correctly simply select the ‘Auto-Assign’ option from the QLOG menu list.
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User Calibration

To select the User Calibration mode sensor operation

The simplest way to calibrate the sensor is to use the QLOG software and switch the sensor into calibration mode

Measurement mode is when the sensor is returning the real-time measurements such as

Raw concentration (ppm),
Temperature Deg-C,

Temperature compensated concentration (ppm),

raw sensor reading in millivolts

as defined in the output variables, see table 2, parameters AMEG

Press the ‘Setup button’ as shown adjacent to the sensor shown in Figure 67 below,

|7 Qlog Recorder

Qlog View Edit Help

s

u

List of devices

Device List Variable List I Formulas I Alarm Levels

T 14KEYNESCOISELECTOENitr0001

ARGES Nitrate E.H Setup | Config | IDv14

Logging N Stopped at 14:27:08

Two menu options are available for selection
1. Nitrate Sensor
2. User Configuration

Select the ‘User Configuration’ option

B Device setup

Device ID I o

Configuration

INitrate Sensor j

Start Column

o =l

Figure 67

|87 Device Setup ? X

Device ID I 1

Configuration
IUser calibration j

Start Column

lo =

[

— -

Figure 68 - Measurement Mode

Figure 69 - User Calibration Mode

The output variables AGME shown in table 2 are only returned in measurement mode. If measurements are taken in user calibration
mode then the results returned may be incorrect or wrongly identified.

ARGES Nitrate Sensor Manual - Version 1.01
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The Sensor Configuration Window shown in figure 70 will appear

=

[ Edit Sensor Configuration 7 x
Property Value tool Set
dentify 14KEYNESCOISELECTT7Mitr0003
Probe Type Mitr*|SELEC;0 Tool ~f Set
Serial number 0003 Tool ~f Set
Minimum underrange 1.00000 Tool ~f Set
Maxirnum overrange 1200.0 Tool ~f Set
Cutput variables AMGE Tool ~f Set
Maolecular ion mass g/Mol 1.0000 Tool ~f Set
Scale mg/L to ppm 1.0000 Tool ~| Set
First point millivolts 321.00 Tool ~f Set
First point pprm 97.000 Tool ~f Set
Second point millivolts 260.00 Tool ~f Set
Second point pprm 970.00 Tool ~f Set
Secondary scale factor 1.0000 Tool ~f Set
Tertiary scale factor 1.0000 Tool ~| Set
Calibration Temperature Deg-C 22,000 Tool ~| Set
Temperature Correction mV/Deg-C 0.75000 Tool ~|| Set

Figure 70 - Nitrate Sensor Configuration Window
The user can adjust some but not all of the parameters in this window; Identifier String, Product Type, and Serial Number cannot be
adjusted. All of the other parameters can be changed by the user.

Enter each new calibration factor into the table, store the values with the ‘Set’ Button. When using a Keynes Controls media converter
the status lights will flash briefly, showing the parameters have been sent to the sensor.

After completing sensor calibration the user should switch the sensor back to the normal mode of operation.
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Measurement Mode Operation

Once the configuration is complete then the user has to set the sensor to return the standard measurements.

Should the user forget to switch the sensor mode of operation the sensor will return measurements but these may not match defined
units shown in the variable list, or panel meter displays.

1. Close the User Configuration Window
2. Select the ‘Setup’ Button adjacent to the Chloride sensor as shown in figure 67 above.
This is on the Device List tab of the QLOG Software.

3. Select the ‘Chloride Sensor’ option as shown in Figure 68 on page 25

QLOG Charts & Panel Meters

Use the ‘View’ Tab to select and configure the real-time charts and panel meters.
The QLOG software supports up to 4 x dual Y axis real-time charts.

4 hY
(2)
)
7 Qlog Recorder - o x
Qlog | Viey Edit Help L
Bl o v
ey Chartl ist | Formuas | AlarmLevels
Chart2
LS chats
Chart4 'WIPERADD2wip243101 IARGES Wiper D..D Setup | Config | IDv1.4| | =
‘/’__‘\ Censole ISELEC106Nitr0001 IARGES Nitrate E.H Setup | Config | IDv1.4
\ 1 | = LCDPanels ¥
\. J
i
6I!614KEYNESCOISELEC 106N trite0001 Nitrite 1R Setup | Config | IDv1.4
TUTIAKEYNESCOFLOURSDTTTryp0001 Tryptophan Fluor 5.AR Setup | Config | IDv1.4
1BI!B14KEYNESCOFLOURSO17Turb0002 [Turbidity (AC.AL Setup | Config | IDv1.4
91!914KEYNESCOFLOURS017DisO0001 Disolved Oxygen (optical) IAM..AGQ Setup | Config | IDv1.4
al'al4KEYNESCOFLOURS0O17CDOMO002 CDOM/FDOM sensor IAR..AV Setup | Config | IDv1.4
=l
LoggingN  Stopped at 1427:08

Figure 71

1 = Panel Meter Selection
2 = Charts Selection
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Identifying the USB-SDI12-AG1 media converter COM Port Number
Use the Windows Device manager

Select ‘Ports (COM LPT)

a list similar to that shown below will appear

Windows 10 Device Manager Window

’ ‘E ;::'\:‘;:""“” The USB-SDI12-AG1 media converter used in the examples above is identified as USB
’ Serial Port (COM 3) as shown in the image opposite.

> fH) Human Interface Devices
» =@ |DE ATA/ATAPI controllers
> Keyboards
» ﬂ Mice and other pointing devices
» O Monitors
> I Network adapters
~ ¥ Other devices
Bi PClEncryption/Decryption Controller
v @ Ports (COM & LPT)
ﬁ Communications Port (COMT)
i USB Serial Port (COM3)
» [ Print queues

Figure 72
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